Welcome to Mac OS 8

Mac OS 8 sets the standard for personal computers. Mac OS 8 features a
beautiful, more responsive interface that will help you to work smarter and
faster. It includes all the features and services you need to harness the power
of the Internet quickly and easily. And with Mac OS 8, it has never been
eader to install, configure, and manage your system.

System requirements

Toinstall Mac OS 8, your computer must have
= aPowerPC™ or 68040 (including the 68L.C040) microprocessor
» at least 8 MB of RAM (16 MB recommended)

Note: Computers that are upgraded with a PowerPC or 68040 processor card
but still have 68030 (or earlier) processors that are accessed during startup
are not supported.

To use Mac OS 8 a computer must have at least 8 MB of RAM (random-
access memory). If your computer has less than 16 MB of built-in RAM, you
must use virtual memory. (Mac OS 8 automatically turns on virtual memory
when you install it) To use the Internet applications provided with Mac OS 8,
your computer must have at least 20 MB of RAM, either built-in or by using
virtual memory.

If you don't know how much RAM your computer has, choose About This
Computer (or About This Macintosh) from the Apple menu (&). Check the
number next to Built-in Memory.
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Where to begin

Chapter 1

To install the recommended software, you need about 95 MB of free space on
your hard disk. To install the optional components, you need about 110 MB of
disk space The exact amount of space needed varies for different computer
models, hard disk sizes, and the optional software you choose to install.

To check the amount of hard disk space you have, open your hard disk icon.
Then choose the icon or small icon view from the View menu and check the
number just below the window's title bar. (The number has the words “MB
available’ after it)

Tip: Many application programs use your hard disk to temporarily store
information, so it's a good idea to keep at least 10 percent of your disk space
free For best performance, you should recheck the amount of available disk
space after installing Mac OS 8.

This manual tells you how to install Mac OS 8. Read the information below
to determine how to get started installing the software

= If you bought Mac OS 8 in order to upgrade your system software, start
with Chapter 2, where you |l learn how to install the upgrade

= If this book came with your new computer, you might already have
Mac OS 8 installed. If itis, start with Chapter 3

If youre not sure if Mac OS 8 is already installed on your computer, follow
these steps to find out:

Turn on your computer.
Open the Apple () menu and choose About This Computer.

Look at the system software version reported in the window.

» |If the window on your computer has a smiling face, Mac OS 8 is already
installed. (The number next to the face is the verson number) Skip ahead
now to Chapter 3 to learn how to configure your computer.

» If the system software version number is less than 80, you can use your
computer with the system software it has, or you can install Mac OS 8 right
now to get started with the newest technology. When youre ready, turn to
Chapter 2 for instructions.



Installing Mac OS 8

Read this chapter for instructions on installing Mac OS 8. The installation
will replace the operating system your computer currently has, but will not
affect your documents or applications.

Before you install Mac OS 8

Before you begin the installation, do the following:
= Turn off any disk-security software you may have

= |f At Ease software isinstalled on your computer, turn it off before you
install Mac OS 8. For instructions, see the manual that came with your
At Ease software or computer.

= Shut down your computer and restart it using the Mac OS 8 disks. See
“Starting Up From the Mac OS 8 Disks” later in this chapter.

WARNING PowerTalk is hot compatible with Mac OS 8. Installing
Mac OS 8 disables PowerTalk. If you use PowerTalk, see “Installing
Over PowerTalk” in Chapter 6 before continuing with the installation
process.
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If you have a PowerBook

If you areinstalling Mac OS 8 on a PowerBook, do the following additional
steps:

= Plug the PowerBook in and set it so it doesrit go to deep.

= Turn off password protection in the Password Security control panel.

You can install Mac OS 8 using a CD-ROM drive attached to (or built into)
your PowerBook, or you can use the Mac OS 8 installation disks. Or, if you
also have a desktop Mac OS computer, you can use it to install Mac OS 8 on
your PowerBook using this method:

= Connect both your PowerBook and your desktop computer to an AppleTalk
or another available network. Put the Mac OS 8 CD in the drive of your
desktop computer, then use File Sharing to access the CD with your
PowerBook over the network. Be sure to run the Install Mac OS 8 program
from your PowerBook, so that the Installer can detect the model of
PowerBook youire using.

Note: Installing Mac OS 8 on a PowerBook in SCSl disk mode is not
recommended. With SCSl disk mode, the Installer cart detect the
PowerBook, and will default to installing software for the model of desktop
computer youre using. You could perform a universal installation, but this
worit install the optimal set of software for your model of PowerBook.



Starting up from the Mac OS 8 disks

You should start up your computer using the Mac OS 8 CD-ROM disc or
floppy disks That way, the installation program can repair any problems on
your hard disk and update the disk driver before it installs the software

If you have the Mac 0S 8 floppy disks

To start up your computer with the Mac OS 8 floppy disks, follow these steps:
1  Shutdown your computer.
2 Insertthe Install Me First disk into the computer’s floppy disk drive.

3 Turn on your computer.

Theinstallation program starts automatically. See the section “Installing the
Software” later in this chapter.

If you have the Mac OS 8 CD-ROM disc

To start up your computer with the Mac OS 8 CD, follow these steps:
1 Insert the Mac OS 8 CD in your computer's CD-ROM drive.
2 Shut down your computer.
3 Turn on your computer while holding down the C key on your keyboard.

Your computer starts up from the CD-ROM disc. Continue holding down the
C key on your keyboard until you see the screen with the smiling face If you
have a PowerBook 1400, you |l need to hold down the $ (Command), Option,
Shift, and Delete keys instead of the C key.

If you have trouble starting up from the CD-ROM disg, see “Problems During
Installation” in Chapter 6.

You Il know youve started up with the CD-ROM disc if you see the CD-ROM
disc icon at the top-right corner of the desktop, above your hard disk icon.

When youve successfully started up with the CD, turn to the section
“Installing the Software”

Installing Mac OS 8
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If you can't start up with the CD

If you don't have an Apple-brand CD-ROM drive, or youire accessing the CD
from your PowerBook using File Sharing, you worit be able to start up from
the CD, but you can still install the software that's on it.

To ensure a smooth installation, turn off any virus-protection software you
have installed.

If you are using System 7.5 or later, open the Extensions Manager control
panel and choose “System 7.5x base’ (or 76.x base) in the Sets pop-up menu.
Then restart the computer.

If you are using an earlier verson of system software, or dorit have the
Extensions Manager, do the following:

Open the System Folder, then open the Extensions folder.
Drag any non-Apple extensions out of the Extensions folder and onto the desktop.

If you don't know where a particular extension came from, click it once to
select it, then choose Get Info from the File menu. If the Version area of the
Get Info window doesrt say “Apple Computer, Inc.,” drag the extension to
the desktop.

Open the Control Panels folder.
Drag any non-Apple control panels out of the Control Panels folder and onto the desktop.

As mentioned in step 2, use the Get Info command if youre not sure whether
to remove a control panel.

Restart your computer.

After youve finished installing the software, you can drag the extensions and
control panels back to your System Folder. For now, it's important to remove
them to avoid any conflicts they may cause when installing the software



Installing the software
After youve started your computer using the CD-ROM disc or floppy disk,
use the Mac OS Installer program to install the software.
= If youreinstalling from the CD, double-click the Install Mac OS 8 icon.
= If you areinstalling from the floppy disk, the Installer opens automatically
when you start up your computer with the disk in the drive

After a moment, a screen appears describing the four stepsin the
installation process.
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The Mac OS Installer guides you through the steps necessary to install the
software. To learn more about each step, click the Help button (@) in the
upper-right corner of the window.

When youire ready to begin, dick Continue Follow the instructions you see
onscreen. Refer to the rest of this section if you need more information about
what you see on your screen.

Reading late-breaking news

Be sure to read the important information displayed by the Installer. Snce the
onscreen information was written later than this manual, it contains the latest
news about installing Mac OS 8.

Installing Mac OS 8



Selecting which software to install

The Mac OS Installer installs the basic components of the system software
In step 4 of the installation process, you can select which software you want
to install in addition to the basic system software. If youre installing from the
Mac OS 8 CD, the following choices are available:

= Mac OS Runtime for Java, for using programs written in the Java™
computer language
= Personal Web Sharing, to share documents using the World Wide Web.

= QuickDraw 3D, to view and manipulate 3D images. Your computer must
have a PowerPC microprocessor to use QuickDraw 3D.

= OpenDoc, to take advantage of software written for the OpenDoc
environment.

s MacLink Plus, to easily open Mac OS DOS, and Windows documents
created in applications you dorit have, using applications you do have
These trandators work with the Mac OS Easy Open control panel.

= Apple Location Manager, a utility for quickly switching between different
settings on your PowerBook computer.

s Cyberdog, an application for accessing the Internet. You must also install
OpenDoc to use Cyberdog.

= QuickDraw GX, to use programs with advanced graphics and typography
features

» Text-to-Speech, to have your computer read text and alert messages aloud.

= Apple Remote Access, to connect to a remote Mac OS computer, such as
your computer at work, using a modem. The computer you connect to
must have the Apple Remote Access Server software installed.

Chapter 2



Responding to messages about your hard disk

The Mac OS Installer checks the destination hard disk for errors before
installing the software. Additionally, if your hard disk was formatted with an
Apple disk utility program, the Installer updates the hard disk drivers with the
latest version of the driver software. If your drives are formatted with a disk
utility from another company, the drivers are not updated. You should use the
third-party disk utility to update your hard disk before installing Mac OS 8.

If there are errors during these procedures, you will see messages on your
screen. See “Problems During Installation” in Chapter 6 for help.

Installing Mac OS 8
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After Installing Mac OS 8

After you install Mac OS 8 and restart your computer, the Mac OS Setup
Assistant appears. The assistant asks you a series of questions, then configures
your computer using the information you provided. See “Using the Mac OS
Setup Assistant” in this chapter for more information.

After youve been usng Mac OS 8 for awhile, you might decide that you
want to add software that you didrit initially choose to install, or you might
want to remove software that youre not using. See “Adding or Removing
Softwarée’ in this chapter for more information.

Using the Mac OS Setup Assistant

1

If necessary, open the Mac OS Setup Assistant.

If youve just installed Mac OS 8, the assistant appears onscreen when you
restart your computer. Or, you can open it yourself by double-clicking itsicon
in the Assistants folder on your hard drive

Mac 03 Setup Asst
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2  Read the introduction then click the arrow at the bottom-right corner of the window.
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You can also navigate to the next window by holding down the 3 key and
pressing the right arrow key.

As you continue with the Mac OS Setup Assistant, you |l be asked to provide
information about yourself, your location, and the settings you want for your
computer. For example, you can enter your name, the current date and time,
and the type of Apple printer you have connected to your computer.

Adding or removing software

The customize option in the Mac OS Installer allows you to add or remove
components of Mac OS 8.

Follow the instructions in this section if you want to

n reinstal al or part of Mac OS 8

» add software products you didrit initially choose to install
= remove some software installed with Mac OS 8

» install additional basic components, such as printer drivers

12 S Chapter 3



Start up from the Mac OS 8 disks and open the Mac OS Installer program.
Refer to the instructions in Chapter 2 for details about these steps.

If youve previoudy installed Mac OS 8 on the destination drive, the Installer
asks if you want to reinstall Mac OS §, or if you want to add or remove
software you select.
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Choose an option.

= If you want to reinstall the basic system software, click Reinstall. Thisis
the same asinstalling Mac OS 8 for the first time See “Installing the
Software” in Chapter 2, for instructions.

= If you want to add new software, or remove software you have installed,
dick Add/Remove Then follow the steps below.

Note: Your screen may look dightly different from the one pictured below. If
youreinstalling from floppy disks, you won't see all the choices available on
the CD.
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After Installing Mac OS 8
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3 Select the software to install, or the software to remove, or both.

As you proceed in the custom installation process, youll be able to determine
exactly which components will be installed or removed for the software you
select.

4  Click Start.

If you see messages about problems with your hard disk, see “ Problems During
Installation” in Chapter 6.

The Installer for the first software product you selected appears. You ll use
the Installer to specify which components of the product you want to install.

5  When you see the Installer's welcome screen, click Continue.

If you want all the recommended components for this product, dick Install.
Then skip ahead to step 9

If you want to install specific components of the software, or remove the
software, follow steps 6-8 below.

6  Open the pop-up menu and choose a menu item.
» If you want to install software, choose Custom Install.
» I you want to remove software, choose Custom Remove

Easy Install
Custom Remove

14 ' Chapter 3
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All available components for the software product appear in the
Installer's window.
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Scroll through the list of components and click the checkbox next to each component
you want to install or remove.

You can see and select individual items within each component by clicking
the arrow to the left of the component, then dicking the item you want to
install. To get additional information about each component listed, dick the
box with the letter i in it to the right of the component.

Click Install or Remove.

If you are installing software, the selected items will be installed on your
computer. If you are removing software, the selected items will be deleted
from your computer.

In either case, the Installer may also remove or delete associated files that are
required for the items you choose

If you have problems while ingtalling, see “ Problems During I nstallation” in
Chapter 6.

Repeat steps 5-8 for all the software you selected.

After you finish installing or removing a software product, the Installer for
the next product you selected opens automatically.

After you've installed all the software you selected, restart your computer.

If you cant restart the computer, see “Problems Using Mac OS 8" in Chapter 6.

After Installing Mac OS 8
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Accessing the Internet

Mac OS 8 comes with software to help you set up and connect to the I nternet.

This chapter describes what you can do on the Internet and how to set up
your computer to access the Internet.

What is the Internet?

The Internet is aloosely knit federation of computer networks that “ speak”
the same language The language is a communications standard known as
the Internet protocal, or IP. The Internet gives you access to a wide variety
of services and information. Some of the most widely used Internet
services include

= electronic mail (e-mail) to exchange messages with other Internet users

= the World Wide Web to access information from all over the world,
including text, color images, music, animation, QuickTime movies, and
virtual reality scenes

= newsgroups (public discussion groups)
s filetransfer protocol (FTP) to transfer files to or from other computers on
the I nternet

Once you are connected to the Internet, you will be able to get the latest
software updates for your computer, read about new products, participate in
user group discussions, and provide feedback to technical support.

17
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What's the difference between the Internet and online services?

An Internet service provider lets you connect your computer to the Internet
through a modem and phone line What you can do on the I nternet once you
are connected depends upon the software you have on your computer. See the
Mac OS Info Center on your hard disk for information about the I nternet
software supplied with Mac OS 8.

Online services, such as America Online (AOL) and CompuServe, also
require you to connect through a modem and a phone line, but they provide
specia content and services available only to their members. Though most
online services allow access to the Internet, members may not necessarily
have access to the full range of Internet information and services. Software for
accessing America Online is on the Mac OS 8 CD.

What you need to connect to the Internet and use your software

To connect to the Internet you need the following:

= A modem capable of transmitting data at 14,400 baud (28,800 baud or
higher recommended) connected to an analog telephone ling, or direct
I nternet access through a local area network.

= 20 MB of RAM. If your computer does not have 20 MB of RAM, then you
must turn on virtual memory and set it to at least 20 MB. Choose Help
from the Help menu on your computer and then select Virtual Memory
from the Index for more information about using virtual memory.

Chapter 4



Setting up your computer to access the Internet

If you are new to the Internet and need to set up access through a modem,
you will first need to register with an Internet service provider. Follow the
instructions in the next section, “ Registering With an Internet Service Provider”

If you already have an account established with an Internet service provider
and want to continue using that account, or if you want to set up access
through alocal area network (LAN), skip to the section “Adding or Modifying
an Internet Configuration.”

If you are an Apple Internet Connection Kit (AICK) user, see the section
“Upgrading From the Apple I nternet Connection Kit,” later in this chapter.

Note: If you plan to use an online service, such as America Online or
CompusServe, contact the online service for instructions on establishing an
account. Software for America Online is available on the Mac OS 8 CD.

Registering with an Internet service provider

To connect to the Internet with a modem, you need to establish an account
with an Internet service provider, or ISP The Internet Setup Assistant
connects you to aregistration server that lets you compare | SPs and register
with one of them. Have your credit card handy and be prepared to write down
some important information your service provider gives you. Then follow the
steps below.

Note: The registration feature is available only in the U.S and Canada.
Canadian customers should read the Internet Access for Canadafile in the
Internet Access in Canada folder located in the Internet Extras folder on your
hard disk or Mac OS 8 CD before using the Internet Setup Assistant.

1 Open the Internet Setup Assistant by double-clicking its icon, located in the Assistants
folder on your hard disk.

Internet Setup Assistant

The Internet Setup Assistant window opens.

Accessing the Internet ¢ 19
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Click Register.

Read the introduction and then click the right arrow located at the bottom of
the window.

You can also move to the next window by holding down the 3 key and
pressing the Right Arrow key.

Follow the onscreen instructions and type the appropriate information on each screen.

You are asked to provide the following information:
= personal information, such as your name and phone number
= information about the modem you are using

Your computer dials the phone and connects to the Netscape Registration
Server. It then launches a World Wide Web browser. Once the browser opens,
you see the Netscape Internet Account Server window which lists I nternet
service providers for your region. The screen you see may not look exactly
like this one:
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Follow the onscreen instructions for selecting an Internet service provider and for
establishing a dial-up Internet account.

Note: The ISP you select may not have dial-up access available in your local
area. Check the phone numbers carefully to be sure you worit be accruing
long-distance or toll charges when you use the service



Write down the important information about your account and about your provider, such
as your e-mail address and the provider’s support number.

Keep the information youve written down in a safe place

Do not store your password where anyone else can access it. For best
security, choose a password that has numbers as well as uppercase and
lowercase letters

Complete the steps for creating an account, then click Configure.

The Netscape Registration Server sends information about your new account
to your computer. Your Web browser quits automatically, and the Internet
Dialer window appears.

Choose your new ISP from the Connect Via menu.
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Click Connect to use your new account.

If you do not want to connect to your new account now, choose Quit from the
File menu.

Congratulations! You now have an Internet account.

Accessing the Internet
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Adding, modifying, or removing an Internet configuration

You use the Internet Setup Assistant to add, modify, or remove I nternet
service provider or LAN information. You may first need to contact your

I nternet service provider or your network administrator to get details about
your Internet service provider account.

Open the Internet Setup Assistant by double-clicking its icon, located in the Assistants
folder on your hard disk.

Internet Setup Assistant

The Internet Setup Assistant window opens.
Click Update.

Read the introduction and then click the arrow located at the bottom right of
the Introduction window.

Select the appropriate action, then click the right arrow to continue.
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4 Follow the onscreen instructions and type the appropriate information on each screen.

You are asked to provide the following information:

aname for your configuration
astatic |P address or a protocol for dynamic configuration

If your dynamic configuration is Macl B, select a Macl P zone where the IP
server is located.

If you are using a static | P address, you are asked to provide a subnet mask
and router address. You may need to ask your network administrator for
these values.

one or more domain name servers (DNS)
adomain name

your e-mail address

your e-mail password

the e-mail account—the name of the remote computer that receives your
e-mail, also called a Post Office Protocol (POP) account

the e-mail host—the name of the computer that processes your outgoing
mail, usually called the Smple Mail Transfer Protocol (SMTP) host

the newsgroup host—the name of the remote computer that provides you
with the Internet news service (Usenet) using Network News Transfer
Protocol (NNTP). (Entering this information is optional )

Consult your network administrator or Internet service provider if you do not
know the appropriate information for your computer.

Setting your preferences for connecting

You use the Internet Setup Utility to choose applications, documents, or files
you want to open automatically after connecting to the Internet, and to select
your active ISP or LAN connection. You can also import I nternet
configurations that you used before upgrading to Mac OS 8.

To choose applications or change default settings, do the following:

1  Open the Internet Utilities folder located in the Internet folder on your hard disk.

Accessing the Internet
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Double-click the Internet Setup Utility icon.

Internet Setup tility

The Internet Setup Utility window opens.

Select the appropriate action.
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You can launch the Internet Setup Assistant to
add, modify, or remove your configurations.

Connecting to the Internet
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If you use a modem, your computer is set to dial automatically into your

I nternet service provider when an application that requires an I nternet
connection is used. If you are connected to a LAN, your computer connects
automatically to the Internet when you launch an Internet application such as
ClarisEmailer™ Lite

If you turn off the auto-dial option in the PPP control panel, or you have
more than one I nternet configuration (such as two ISP accounts or an ISP
account and a LAN connection) you use the Internet Dialer to connect.



Follow these steps to use the Internet Dialer:
1  Open the Internet folder on your hard disk.

2  Double-click the Internet Dialer icon.

Internet Dialer

3  Choose the connection you want to use from the Connect Via menu.
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4 Click Connect.

Once a connection is established, the Connect button changes to Disconnect.
You can use this button to disconnect from the Internet when you are done
See the section “ Disconnecting From the Internet,” next.

You can view the Internet Dialer window to keep track of how long youre
connected to the Internet.

5 Once you are connected, open the Internet application that you want to use (such as
Netscape Navigator or Claris Emailer Lite).

Disconnecting from the Internet

If you use a modem, dorit forget to disconnect from the Internet. Quitting an
application program worit automatically hang up the phone When you quit
an application such as Netscape Navigator™ or Claris Emailer, you are still
connected to the Internet, and you will accrue connection time and
potentially be charged for that time

Your computer is set to disconnect your modem after ten minutes of network
inactivity. You can adjust the amount of inactive time needed to trigger an
automatic disconnect, or turn off this option, in the PPP control panel.

Accessing the Internet ¢ 25
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To disconnect when using a modem:
Quit each of the Internet applications you have open.
Click on the Internet Dialer window to make it active.

If the Internet Dialer is not already open, double-click itsicon located in the
Internet folder on your hard disk.

Choose Disconnect.
To disconnect when connected through a LAN, do this:
= Quit each of the Internet applications you have open.

Once you have quit I nternet applications such as a Web browser and an e-
mail program, you will be disconnected from the Internet. You do not need to
do anything else

Upgrading from the Apple Internet Connection Kit

After installing Internet Access for Mac OS 8, your AICK preferences are
converted automatically after restarting your computer. If you used a connect
script in AICK to connect to your Internet service provider, see the section
“I'mporting Connect Scripts” next.

Importing connect scripts

Chapter 4

You may need to import a connect script if either of the following is true:
= Your Internet service provider requires you to use a connect script.

= You are upgrading from AICK to Internet Access for Mac OS 8, and you
used a connect script in AICK.

Before you follow these steps, be sure the connect script that you want to
import is on your hard disk. Then follow these steps:



Choose PPP from the control panel menu.

If your user name and password, and your | SP's phone number do not appear

in the PPP control panel, enter them now.
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Click Options and then click the Protocol tab.

The Protocol window appears.
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Click the checkbox next to “Connect to a command-line host.”

Click the “Use terminal window” button, then click OK.

The PPP control panel reappears.

Accessing the Internet
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5  Click Connect.

The PPP Terminal window appears after the modem has made a connection.

{# PFP Tarininal

ieging =
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6  Click Settings.
The PPP Terminal Settings window appears.
7 Click the checkbox next to “Prompt to save Connect Script on close.”
Make sure “ Close Terminal when PPP is started” is also checked.
8  Click OK.
The PPP Terminal window reappears.
9  Enter the appropriate information at each prompt.

You are asked for information such as your user name and password. If you
don't know all the information, contact your Internet service provider.

Once you have entered the appropriate information, click Continue
10  Enter aname for your connect script, then click Save.
Once your script is saved, the PPP control panel reappears.

11  Click Disconnect in the PPP control panel, and then click Options.
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12  Click the “Use connect script” button, and then click Import Script.

A dialog box appears.
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13 Select your connect script and click Open.

Your connect script is the file you saved in step 10. Once you click Open, the
Protocol window reappears.

14  Click OK.

The PPP control panel reappears.
15  Close the PPP control panel.

A dialog box appears; dick Save

You may now connect to this Internet service provider. See the section
“Connecting to the Internet,” earlier in this chapter.
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Learning About Mac OS 8

Mac OS 8 includes many new features and enhancements. The Mac OS Info
Center is a new onscreen reference for information about the Mac OS You
can use the Info Center to find out what's new and how to get the most out of
the features of Mac OS 8.

Using the Mac OS Info Center

1  Double-click the Mac OS Info Center icon on your desktop.

Maz 05 Info Center

If youre asked to locate a Web browser, choose one of the programs shown
in the dialog box. If you dorit have a browser on your computer, install the
I nternet applications provided with Mac OS 8. See “Adding or Removing
Software’ in Chapter 3
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The Mac OS Info Center uses a Web browser, such as Netscape Navigator, to
display itsinformation. Your computer must have enough memory to load a
Web browser, but it does not need to be connected to the Internet in order to
use the Mac OS Info Center. Most of the files are stored on your hard disk.

O Hekscape; Mac 0F Info Certer

E MacOS

Info Center

T ST isdd @ IEeniel Cohietiion [0 WS U o Génber.
Click 3 pichyre B==low bo get sharted.

Showw M
Wheat | Can Do

2 To begin, click Show Me What | Can Do.
3 Onthe “Discovering What You Can Do” page, click “What's New in the Mac OS.”
Click atopic areato read about the new Mac OS features in that category.
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Where to find help

The Info Center is just one of the places you can look for information about
using Mac OS 8. Refer to these other valuable sources of information about
using your computer.

Onscreen help

The Help menu is your main source of “how to” information about the
Mac OS Many application programs also have onscreen help.

To view onscreen help, switch to the program you want to use, then look in
the Help menu.

About Help
Show Balloons

Help ®?

Late-breaking news

If you have questions about compatibility or other late-breaking news about
your software, refer to the “Read M€’ documentsin the Mac OS Read Me
Files folder on your hard disk and the Mac OS 8 CD-ROM disc.

N

kdac 0% Read ke Files

If youre connected to the Internet, be sure to also check the “late-breaking
news’ information link in the Info Center.

Learning about Mac OS 8
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On the Internet

Vist Applés home page on the World Wide Web. You Il find links to alarge
number of resources, including technical support and product information.

For information about the Internet software included with Mac OS 8, see the
I nternet resources supplied by the manufacturers of the software

Software

Aladdin Stufflt

Apple Computer, Inc.
Apple Live Home Page
Apple QuickTime
Adobe Acrobat

Claris Emailer Lite

Live Audio

Macromedia Shockwave

Netscape Navigator

WWW address

http://www.aladdinsys.com
http://www.apple.com
http://livepage.apple.com
http://quicktime.apple.com
http://www.adobe.com

http://www.claris.com
http://www.emerald.net/liveaudio/default.htm
http://www.macromedia.com

http://www.netscape.com



Troubleshooting

If you encounter problems when installing Mac OS 8, read this chapter for
some common solutions,

Problems during installation

This section helps you solve problems you may encounter while installing
your software.

You can't start up the computer using the Mac OS 8 CD-ROM disc or the Mac OS 8 Install
Me First disk.

Cause: Your computer located the system software on your hard disk before it
located the system software on the CD or floppy disk. If you have an external
hard drive with system software, the computer may locate and boot from that
device instead of the CD-ROM disc.

Solution: With the CD or floppy disk inserted, open the Startup Disk control
panel and dick the CD or floppy disk icon. Then restart the computer.

You Il need to reselect your hard disk as the startup disk after you install the
software. Open the Startup Disk control panel again and click the icon for
your hard disk. Then restart your compulter.
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The Installer cannot repair your hard disk.
Cause: The Mac OS Installer is unable to repair your problem.

Solution 1: If you see a message that the disk cant be fixed because a

fileis open, quit all programs. If file sharing is on, turn it off. Then try
installing again.

Solution 2: Use athird-party disk repair utility to seeif it can repair the disk.

If you don't have a third-party utility, or if that utility carit repair the disk
either, you may need to reinitialize the hard disk.

First, back up your hard disk because reintializing erases everything on the
disk. Then use the Drive Setup utility program to reinitialize the disk. If your
hard disk is not an Apple hard disk, use the disk utility software provided by
the manufacturer instead of Drive Setup.

You can find Drive Setup in the Utilities folder on the Mac OS 8 CD-ROM
disc, or on the Disk Tools floppy disk. To reinitialize your startup disk (the disk
with system software on it) you need to start up the computer from a different
disk. You can start up using the Mac OS 8 CD-ROM disc or Disk Tools floppy
disk. See “Starting Up From the Mac OS 8 Disks’ in Chapter 2 for
instructions.

After youve reinitialized the disk, use the Mac OS 8 Installer to reinstall
system software, then reinstall your application programs.

For more information about reinitializing your hard disk, see the manuals that
came with your computer.

The Installer cannot update the hard disk driver.

Cause 1: You dorit have an Apple-brand hard disk or you dort have an
Apple-brand computer.

Solution 1: Use the disk utility recommended by the manufacturer of your
computer or hard disk to update the drivers on your system before installing
Mac OS 8 Make aure to get the latest verson of the utility from the
manufacturer. An old utility will not be able to update your disk with the most
current driver. If you have a Zip drive, you can update the driver for it using
the software in the lomega Tools folder, in the CD Extras folder, on the

Mac OS 8 CD.



Cause 2: Youve previoudy updated your Apple hard disk with a non-Apple
disk utility.

Solution 2: You need to use the utility you used previoudy to update the driver
again. To ensure a successful update, obtain the latest version of the utility.

Cause 3: Some hard disks must be reinitialized before you can update the
driver.

Solution 3: Back up all the files on the hard disk, then use Drive Setup to
reinitialize the hard disk. For instructions on reinitializing the hard disk, see
the manual that came with your computer, but use Drive Setup provided with
Mac OS 8 to perform the initialization, even if another Apple program was
supplied with your computer.

You see a message that there’s not enough memory to use the Installer.

Cause 1: You didnt start up the computer using the Mac OS 8 CD-ROM disc
or floppy disk.

Solution 1: See “Starting Up From the Mac OS 8 Disks’ in Chapter 2.
Cause 2: You have too many applications open.

Solution 2: Quit all open application programs.

Cause 3: You have too many system extensions running.

Solution 3: If you have system software version 75 or later, open the
Extensions Manager control panel and choose “ System 7.5x basé’ (or 76.x
base) from the Sets menu; then restart the computer. If you have an earlier
version of system software, hold down the Shift key while you restart the
computer. Thisturns off all system extensions.

Cause 4: Your disk cache or RAM DisKk setting is set too high in the Memory
control panel.

Solution 4: Open the Memory control panel, set your disk cache to the lowest
possible setting, and reduce or turn off your RAM disk. Then restart the
compulter.

Troubleshooting
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You see a message that your computer doesn’t have enough memory to use
the software.

Cause: Your computer has less RAM than is required to use Mac OS 8.

Solution:  For memory guidelines, see “System Requirements’ in Chapter 1 If
necessary, contact your computer dealer for information about how to
purchase additional memory.

You see a message that there’s not enough disk space.

Cause:  Your computer's hard disk has less than the minimum amount of
space required to install the software

Solution: Make more space available on your hard disk by removing some
files from the disk. Make backup copies of the files, if desired. Then drag
them to the Trash icon and choose Empty Trash from the Special menu. You
dorit need to quit the Installer before you remove files from the disk.

When you see this message, some of the software you selected may have been
successfully installed. The Install Software window in the Installer program
indicates which software has already been installed. (When you quit the
Installer, the list of software already installed is no longer available)

You see a message that the System file cannot be modified.

Cause 1: You have installed virus-protection software that guards agai nst
modification of the System file

Solution 1: Start up your computer from the Mac OS 8 CD-ROM disc or
floppy disk, as described in “Starting Up From the Mac OS 8 Disks' in
Chapter 2.

Solution 2: Drag any virus-protection software out of the System Folder and
restart your computer. You can put the virus-protection software back after
installation.

Cause 2: The System and Finder files may be locked.

Solution 2: To seeif your System file or Finder file is locked, select the filés
icon. Then open the File menu and choose Get Info. To unlock the file, click
the Locked checkbox to remove the mark.



You see a message that the installation was not successful.
Cause: You may have an incompatible item in your System Folder.

Solution 1: Start up your computer using the Mac OS 8 CD-ROM disc or the
floppy disk. See “Starting Up From the Mac OS 8 Disks’ in Chapter 2.

Solution 2: If you have a non-Apple CD-ROM drive and carit start up from
the CD, try restarting your computer with only those extensions provided with
your version of system software

= |f you are using System 7.5 or later, you can open the Extensions Manager
control panel and choose “ System 7.5x base’ (or 76.x base) in the Sets
pop-up menu. Then restart the computer.

s |If you are using an earlier version of system software, drag any non-Apple
extensions out of your Extensions folder and onto the desktop, then restart
the computer. (If you don't know where a particular extension came from,
select itsicon. Then choose Get Info from the File menu. Apple extensions
al have “© Apple Computer, Inc” in the Verson section of the Get Info
box.)

Problems using Mac OS 8

This section helps with problems you may encounter using the computer after
you have installed Mac OS 8.

You can't start up or restart the computer, or when you do you see a bomb message.
Cause 1: You probably have an incompatible item in the System Folder.

Solution 1: Follow the instructions in “ Resolving Software Conflicts” later in
this chapter.

Cause 2: Your system software may have been damaged.

Solution 2: Follow the instructions in “ Performing a Clean Installation,” later
in this chapter, to reinstall system software

Application programs freeze, or require you to restart the computer.

Cause: You may have an incompatible item in the System Folder or the
application program is incompatible with Mac OS 8.

Solution: Follow the instructions in “ Resolving Software Conflicts” later in
this chapter.
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For compatibility information on application programs, contact the programs
manufacturer. You may have a version of the program that doesrit work with
Mac OS 8.

None of your network devices appear in the Chooser.
Cause 1: AppleTak is not turned on.

Solution 1: Make sure AppleTalk is turned on in the Chooser and that the
correct port is selected in the AppleTalk control panel. If AppleTalk isturned
on, make sure you have chosen the correct port in the “Connect via' pop-up
menu in the AppleTalk control panel.

Cause 2: Thereis aconflict between your network number and another
network number.

Solution 2 If your network number or node number has been set to “User
Defined,” turn off the User Defined setting in the AppleTalk control panel.
Then cose and reopen the control panel.

For complete AppleTalk setup instructions, see Mac OS Help, available in the
Help menu when the Finder is active

You can't connect to devices outside your local network.

Cause: Your router address or subnet mask hasrit been entered correctly.

Solution: Make sure your router address and subnet mask are entered
correctly in the TCP/IP control panel. Check with your network administrator
or Internet service provider for the correct values to enter.

For complete TCP/IP setup instructions, see Mac OS Help, available in the
Help menu when the Finder is active

You notice visual inconsistencies or odd appearance in some programs.

Cause:  Some programs are not compatible with the new appearance of
Mac OS 8.

Solution:  These cosmetic problems will not affect the way the programs
work, but if the inconsistencies bother you turn off the system-wide
appearance checkbox in the Appearance control panel. Contact the
manufacturer of the program to see if an updated version is available



Resolving software conflicts

If your computer does not start up properly or behaves erratically, you
probably have an incompatible extension, control panel, or application.

Step 1: Verify the problem
To verify that you have a compatibility problem, follow the steps below.

Start up your computer while holding down the Space bar.

Holding down the Space bar opens the Extensions Manager control panel
during startup.

Release the Space bar when the Extensions Manager control panel opens.
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Open the Selected Set menu and choose Mac OS 8 base System.

Thisturns off all extensgons and control panels except those installed with
Mac OS 8.

Close the Extensions Manager control panel to continue startup.
When the computer is ready, try the same actions that caused the problem.

If the problem no longer occurs, you probably have an extension or control
pandl that doesrit work with Mac OS 8. Continue with the stepsin “Step 2:
Test Individual Extensions and Control Panels’ to identify the item that is
causi ng the problem.

Troubleshooting
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If the problem still occurs, try checking your hard disk for problems with the
Disk First Aid utility. You can find Disk First Aid in the Utilities folder on the
Mac OS 8 CD or on the Disk Tools floppy disk. You should also check to make
sure that your application programs are compatible with Mac OS 8. If the
problem occurs only when using a certain program, that program is probably
not compatible Check with the programs manufacturer for information.

Step 2: Test individual extensions and control panels

To test an individual extension or control panel for compatibility, follow the
steps below.

1 Start up your computer while holding down the Space bar.

Holding down the Space bar opens the Extensions Manager control panel
during startup.

2  Release the Space bar when the Extensions Manager control panel opens.
3 Turn on the item you want to test by clicking its checkbox.

4 Close the Extensions Manager to continue startup.

5  Try the same actions that caused the problem.

If the problem does not occur again, then the item is probably compatible
with Mac OS 8.

If the problem occurs again, the item is probably incompatible Open the
Extensions Manager control panel and click the itenis name to turn off the
checkbox.

6  Repeat steps 1through 5 for each item you want to test.

If you find that a piece of software isincompatible, turn it off or remove it
from your computer, then contact the manufacturer of the software to see if
an updated version is available
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Performing a clean installation

This section provides instructions for what is commonly called a dean
ingtallation of system software

A normal system software installation replaces changed system files and adds
new ones, but leaves other files alone When you install system software using
aclean installation, the Installer creates a new System Folder on your hard
disk. The old System Folder is renamed Previous System Folder. Snce your
computer has a new System Folder, you must reinstall any third-party
extensions and control panels after a clean installation. Application programs
and documents are not replaced or changed.

Performing a clean installation can be a complicated procedure, but if you are
experiencing problems or your computer seems dow, it may help.

If your computer came with software that was already installed, some of those
programs might need to be reinstalled after you perform a clean installation.
See the manuals that came with your computer for information.

Follow these steps to perform your clean installation.

1  Start up your computer from the Mac OS 8 CD-ROM disc or from the Mac OS 8 Install Me
First disk, as described in “Starting Up From the Mac OS 8 Disks” in Chapter 2.

2 Open the Mac OS Installer application.
3 Inthe Welcome dialog box, click continue.

The Select Destination dialog box appears.
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Click the Perform Clean Installation checkbox so that it has a mark in it.
Click Select.
Select the software products you want to install.

For more information about the choices available, or for instructions on
further customizing your selections, see Chapter 3

Click Start to install the software you've selected.

A new System Folder isinstalled on your hard disk. (The old System Folder is
renamed Previous System Folder)

When the Mac OS Installer is finished, you can reinstall extensions, fonts,
control panels, and other items not installed with Mac OS 8 from their
original disks If you don't have the original disks, you can drag these items
one at atime from the Previous System Folder to the new System Folder.
Restart your computer after you reinstall each item, to make sure the software
is compatible with Mac OS 8.

After youre sure that youve copied all the items you want to save into your
new System Folder, delete the Previous System Folder from your hard disk.

Problems setting up Internet access

Chapter 6

The list of modem types in the Modem Settings window does not include the name of
your modem.

Solution: Copy the modem script file (CCL) supplied with your modem into
the Modem Scripts folder in the Extensions folder. Additional modem scripts
are available in the CD Extras folder on the Mac OS 8 CD. If you carit find a
script for your modem, contact the manufacturer of the modem to get thisfile
Oncethefileis copied into the Modem Scripts folder, your modem will
appear as a choice the next time you launch the I nternet Setup Assistant.

You have an internal modem, but the Modem Port menu in the Modem Settings window
does not include Internal Modem as a choice.

Solution: If your computer has an internal modem, but it does not appear as a
choice, then Modem Port is the correct selection.



Your modem appears in the list of modem types in the Modem Settings window, but your
modem does not seem to be working.

» Check to see that your modem is turned on and connected to your
computer and to your phone line correctly.

= You may need to contact the modem vendor to get an updated modem
script. Once you get this script, copy it into the Modem Scripts folder in
the Extensions folder located in your System Folder.

Problems creating an Internet account or connecting

While you are attempting to create a new account, the line seems to have dropped or you
get no response from the computer your modem has called.

Solution: When you try to create an account, the ISP Setup Assistant places a
call to an Internet registration server and launches a World Wide Web
browser. If you experience problems at that point, you must quit the Web
browser. If you see a dialog box that asks you if you want to continue, click
Continue. Sometimes the remote computer is busy temporarily and you can
try to create the account again almost immediately.

You cannot connect to an online service using the Internet Setup Assistant.

Cause: The Internet Setup Assistant is designed to connect your computer to
an Internet service provider. It is not designed for use with online service
providers such as America Online or CompuServe

Solution: Contact the online service for software and instructions on how to
set up an account with them. America Online software is provided on the
Mac OS 8 CD.

You see a “Trouble with Assistant” window when you attempt to connect.

» Check to see that the correct port is selected for your modem, and that
your modem is turned on and connected properly to your computer and to
an analog phoneline

= Your modem initialization string may not be working correctly. You may
need to contact the modem vendor to get an updated modem script.

Troubleshooting
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You cannot set up Internet access through a LAN and you used BootP or DHCP with
your previous version of the Mac OS.

Solution:  You need to use the TCP/IP control panel to configure your I nternet
access manually. Choose Help from the Help menu on your computer for
information about the TCP/I P control panel.

Problems with your World Wide Web browser

Chapter 6

The following problems may occur when you use the Internet Setup
Assistant. See the documentation for your World Wide Web browser or
contact the manufacturer of the browser directly for assistance and
troubleshooting information.

Your Web browser “freezes” (doesn’t respond to input from the keyboard or mouse)
whenever it's opened.

Cause: You may need to increase the amount of RAM available to
this application.

Solution 1: If your computer does not have 20 MB of RAM, then you must
turn virtual memory on so that your RAM and virtual memory total at least
20 MB. For more information see the Memory topic in the onscreen help,
available in the Help menu on your computer.

Solution 2: If you have at least 20 megabytes of RAM, you may need to quit
other applications that you have running, and you may need to increase the
amount of RAM available to your browser by using the Get Info command.
For more information see the Memory topic in the Help menu on

your computer.

You see a message saying “This server does not have a DNS entry.”

Cause: The server that you are attempting to access may be shut down or not
operating correctly.

Solution 1 Since the situation may only be temporary, try connecting at
another time

Solution 2: 1f you typed the URL (uniform resource locator) of the
destination page, check to be sure that youve typed it correctly. You may have
omitted aletter or used incorrect capitalization.



The Netscape Navigator plug-ins you were using before you installed Mac OS 8 are no
longer working.

Cause: When Mac OS 8 was installed, a new Netscape Navigator folder was
created in the Internet Applications folder located in the Internet folder on
your start up disk.

Solution:  You must move your plug-ins to the plug-in folder located in this
Netscape Navigator folder.

You see a message that your browser is “unable to create a network socket connection.”
Cause: Your connection to the Internet may have closed.

Solution 1: Check the status on the Internet Dialer. You may need to connect
to the Internet again.

Solution 2: 1n some cases, you may heed to quit and restart your browser.

Installing over PowerTalk

3

PowerTalk is not compatible with Mac OS 8. Once you install Mac OS 8, you
will not be able to use PowerTalk services, including

= your PowerTalk keychain

= personal catalogs

= your PowerTalk mailbox

= the AppleMail application program
= digital sgnatures

= PowerShare server mail and services

After you install Mac OS 8, you no longer see your mailbox and keychain
icons. You see your personal catalogs, but you worit be able to open them.
Additionally, you can only access AppleMail messages that were saved as text
files and moved out of your PowerTalk mailbox before you installed Mac OS 8.

To save your messages as text files, follow these steps:
Open a PowerTalk mail message.
Open the File menu and choose Save As Text.

In the dialog box that appears, choose a name for the message.

Troubleshooting
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Choose alocation in which to store the text message.
You can save the file in any folder on your hard disk.

Tools to help save and convert your PowerTalk information are available on
the World Wide Web at the following address:

http://devworld.apple.com/dev/powertal k/
If you have Internet access, use these tools before you install Mac OS 8.



Installation Manual



& Apple Computer, Inc.
© 1997 Apple Computer, Inc. All rights reserved.

Under the copyright laws, this manual may not be copied, in whole or in part, without the
written consent of Apple. Your rights to the software are governed by the accompanying
software license agreement.

The Applelogo is atrademark of Apple Computer, Inc., registered in the U.S. and other
countries. Use of the “keyboard” Apple logo (Option-Shift-K) for commercial purposes without
the prior written consent of Apple may constitute trademark infringement and unfair
competition in violation of federal and state laws.

Every effort has been made to ensure that the information in this manual is accurate. Appleis
not responsible for printing or clerical errors.

Apple Computer, Inc.

1 Infinite Loop

Cupertino, CA 95014-2084
408-996-1010
http://www.apple.com

Apple, the Applelogo, AppleMail, AppleTalk, Macintosh, Mac OS, OpenDoc, PowerBook,
PowerShare, PowerTalk, QuickDraw, and QuickTime are trademarks of Apple Computer, Inc.,
registered in the U.S. and other countries.

At Ease, Cyberdog, Disk First Aid, Extensions Manager, and Finder are trademarks of Apple
Computer, Inc.

Acrobat, Adobe, Adobe Illustrator, Adobe Photoshop, and PostScript are trademarks of Adobe
Systems Incorporated or its subsidiaries and may be registered in certain jurisdictions.

Clarisis aregistered trademark and Claris Emailer is atrademark of Claris Corporation.
Javais atrademark of Sun Microsystems, Inc.
Netscape Navigator is atrademark of Netscape Communications Corporation.

PowerPC is atrademark of International Business Machines Corporation, used under license
therefrom.

Other company and product names mentioned herein are trademarks of their respective
companies. Mention of third-party productsis for informational purposes only and constitutes
neither an endorsement nor arecommendation. Apple assumes no responsibility with regard to
the performance or use of these products.

Simultaneously published in the United States and Canada.



Contents

Welcome to Mac 0S8 1
Systemrequirements 1
Where to begin 2

Installing Mac 0S8 3
Before you install Mac OS 8 3
If you have a PowerBook 4
Starting up fromthe Mac OS8 disks 5
If you have the Mac OS 8 floppy disks 5
If you have the Mac OS 8 CD-ROM disc
If you carnit start up with the CD 6
Installing the softwvare 7
Reading late-breaking news 7
Selecting which software to install 8
Responding to messages about your hard disk

After Installing Mac 0S8 11
Using the Mac OS Setup Assistant n
Adding or removing software 12

5

9



Contents

4 Accessing the Internet 17

What isthe Internet? 17

What's the difference between the Internet and online services?
What you need to connect to the Internet and use your software
Setting up your computer to access the Internet 19

Registering with an Internet service provider 19

Adding, modifying, or removing an Internet configuration 22
Setting your preferences for connecting 23
Connecting to the Internet 24
Disconnecting from the Internet 25
Upgrading from the Apple Internet Connection Kit 26
Importing connect scripts 26

Learning About Mac 0S8 31

Using the Mac OS Info Center K1l

Whereto find help 33
Onscreenhelp 33
Late-breaking news 33
Onthelnternet 34

Troubleshooting 35
Problems during installation 35
ProblemsusngMac 0S8 39
Resolving software conflicts 41

Step 1: Verify theproblem 41

Step 2: Test individual extensions and control panels 42
Performing aclean installation 43
Problems setting up Internet access 44
Problems creating an Internet account or connecting 45
Problems with your World Wide Web browser 46
Installing over PowerTalk 47

18

18



